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Controls
Click on the Control for help on that Control.

These controls make CD Tray perform the various 
playing functions just like a real CD player.



Artist / Title Window

The Artist / Title Window contains only two edit entries.
They are used to input the Artist's name and the Title
of the Compact Disk.

When entering the Artist and Title information, press the 
Tab to move the input focus between the two inputs.    
Press Shift-Tab to move backwards.    Press Return when
you are done inputting the Artist and Title information.

After inputting or editing information in this window, 
choose Save Disk Info from the    Disk Menu to save
your edits to the CD Library.    CD Tray will prompt you 
if you forget.



Songs Window

The Songs Window is where the song titles are displayed.
The titles are initially blank and you must input them.    No 
song title information is contained on an audio compact
disk.      Listed beside each song edit line, are the lengths 
of that corresponding track on the compact disk.    Note that
the lengths may not match exactly any lengths that are written
on the compact disk.    However, these are the track lengths
that are returned to CD Tray from the compact disk.    Lengths
between songs probably accounts for some of the discrepency.

A scroll bar is provided to scroll the window up or down to tracks 
not currently shown.    You may also use the Up/Down arrows 
and PgUp/PgDown to scroll this window.    The song currently 
playing or programmed will be shown in red.

When entering track titles, pressing the Tab key will
move the input focus to the next track's input entry line.    
Press Shift-Tab to move backwards.    Press Return 
when you are done inputting track titles.    Pressing 
Return will erase the flashing caret within the song title
edit controls and return focus back to the Songs Window.

After inputting information in this window, choose 
Save Disk Info from the    Disk Menu to save
your edits to the CD Library.    CD Tray will prompt
you if you forget before exiting.

To the left of each song, are Play buttons which you 
may click on to play a song instantly.    If CD Tray is
currently playing, it will skip to that track.    If CD Tray
is stopped, that track will start playing.These buttons 
are disabled when CD Tray is in program mode.



Disks Window

In the Disks Window, you may browse the compact 
disks that are in the Disk Library.    You may also 
edit the information contained in each record.

Scroll bars are provided to scroll the window vertically
to disks not shown and horizontally to reveal other 
fields in the compact disk record.    You may also use 
the Up/Down, Right/Left arrows and PgUp/PgDown to
scroll this window.    Note that pressing the Ctrl key while
pressing one of the above keys will scroll the window in
larger increments.

Also, when the Disks Window is active, the Library menu
item is enabled.

Double click with the mouse on a compact disk record entry
to enable the Disk Edit dialog    for the disk.    This dialog allows
editting and deleting of individual compact disks.



Menu Commands

Click the menu item for a description of that item.

You may press F1 at any menu item for context
sensitive help on that menu.



Dialogs
Disk Edit Dialog - Used by the Disks Window, allows editting
of a compact disk record in the Disk Library.

Print Dialog - used to control printing of the Disk Library.

Filter by Category Dialog - select a Category of compact disks
to be browsed in the Disks Window.

Compact Disk Library Information Dialog - presents a summary
of various information about the Compact Disk Library.    



Tools
Fast Forward / Rewind Dialog - A tool used for fast forwarding,
rewinding and cueing.

Segment Play Dialog - A tool used to play track passages. It is
used primarily for recording purposes or amusement.

Track Programming Dialog - A tool that allows you to choose 
the particular tracks you wish to play on the compact disk.

Review Program Dialog - A dialog which lists the tracks that
are currently programmed.    

Continuous Play - Makes CD Tray exit program mode.    Tracks
will then be played in order.    This item is only displayed when
CD Tray is in program mode.

Restart Current Track - selecting this will make CD Tray
restart the track that is currently playing.    This item is 
disabled when CD Tray is stopped.

Track Repeat - Select this    item to make CD Tray play the
current track continuously.    When this menu item is checked, 
Track Repeat is on.

Disk Repeat - Select this    item to make CD Tray play the
current compact disk continuously.    When this menu item is 
checked Disk Repeat is on.

More Tools - reveals another popup menu with tools or programs
you wish to execute from CD Tray.

Add a Tool - allows you to specify other tools or programs you 
wish to execute from CD Tray.    

Delete a Tool - presents a dialog with which you may delete
any of the user-defined tools added to CD Tray's Tools menu.



Graphics Windows
These windows are for show only and just might 
make listening to music at your computer a little 
more relaxing.

Look for new, more specialized    windows in future 
versions of CD Tray!    The possibilities are endless.



Product Support
Technical Support will be provided through two means:

        1) By mail to JenJen Software.

        2) Electronically through CompuServe. (Compuserve ID#    73700,3137)

        Note:    Please include your phone number in case a phone call
                                  is required.

Technical Support is unlimited to registered users.    

Also, if you have suggestions for the improvement of CD Tray, please 
contact JenJen Software.    All suggestions are welcome!



CD Tray
Audio Compact Disk Player and Compact Disk Library

© 1993    JenJen Software
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A Control is one of the large buttons on CD Tray.
These buttons control operation of the player for Playing, Stopping, etc.

These buttons are duplicated on the Menu.



Play the compact disk loaded in your CD ROM drive.

This control is disabled if the CD ROM is currently playing
or there is no disk in the CD ROM drive.



CD Tray mode in which you choose the particular tracks 
you wish to play on the compact disk.    You may choose 
as many or as few tracks as you wish.



Stop playing the compact disk in your CD ROM drive.

This control is disabled if the CD ROM is currently stopped
or there is no disk in the CD ROM drive.



Pause or Resume playing the compact disk in the CD ROM drive.

If CD Tray is paused, clicking this control will resume play.
This control is disabled if the CD ROM is currently stopped
or there is no disk in the CD ROM drive.



Skip LEFT to previous track.

If CD Tray is currently playing, the previous track    will
start playing.    If CD Tray is stopped the previous track
will be cued for playing.

If CD Tray is in Program Mode the previous track that
is programmed will be played or cued.



Skip RIGHT to next track.

If CD Tray is currently playing, the next track    will
start playing.    If CD Tray is stopped the next track
will be cued for playing.

If CD Tray is in Program Mode the next track that
is programmed will be played or cued.



Eject the compact disk from the CD ROM drive.

This control is disabled if the CD ROM is currently playing
or there is no disk in the CD ROM drive.    The Eject button
on your CD ROM drive will still eject the disk while playing.



Compact Disk Record Entries
CD Tray uses the following record structure for compact disk records in the 
Disk Library.

All the information must be input for each disk.

        Artist                                                                - name of the performer, ie "Fleetwood Mac"
        Title                                                                  - name the performer has given to the disk, ie 
"Rumours"
        Category                                              - a musical category for the disk, ie "Soft Rock"
        Puchase Information - any other information you would like to keep
                                                                                                about this disk.    An example might    be the
                                                                                                place the disk was purchased.
        Cost                                                                - The amount of money paid for the disk or what you 
think
                                                                                                the monetary value of this compact disk is 
worth.    
        Songs                                                        -    The song titles the performer has given the songs on
                                                                                                  this compact disk.    Up to 50 songs may be 
stored.
                                                                                                  All song time information is also stored here.  
The time
                                                                                                  information is stored automatically by CD 
Tray.
        Favorite Tracks                    - a track program, if any, that has been saved by CD Tray.



The CD Library is a database of all your compact disks.
The files are CDTRAY.DAT & CDTRAY.IXC.    The .DAT
is the data file and the .IXC file is the index file.    Both are
necessary to run CD Tray and both must be in the 
directory specified by the entry "DbDirectory=" in the
CDTRAY.INI configuration file.    CDTRAY.INI will be
located in the WINDOWS default directory.



Cueing is positioning the read mechanism of the
CD ROM drive to a certain position on the compact disk.



Disk Edit Dialog

The Disk Edit dialog provides a means to edit the
different fields of a compact disk record in the 
Compact Disk Library.

You may edit the Artist and Title information previously
entered into the Artist / Title Window.    

Instead of edit controls, combo boxes are used to input the 
other informational type fields.    These combo boxes contain
each unique entry for that field in the Compact Disk Library.    
If you wish to enter new information, click the New button 
beside that corresponding field.    This will present a dialog
for entering the new information.    Enter the information and 
click Ok to save.

Also, in this dialog is a list box for the song titles for this
compact disk.    Each song title is preceded with the length
of the track.    Click on the song title.    This will present a
dialog to edit the song title.    Enter the information and click
Ok to save.

After editing any of the compact disk record's information,
click the Save button to save or click Cancel to discard the
edits.

If you wish to delete this compact disk from the Compact Disk
Library, click the Delete button.    After confirmation, the disk
will be deleted.



Print Dialog

This dialog is used to control printing compact disk
records from the Compact Disk Library.

Various options are allowed when printing. 
First, choose the sorted order for the disks.    The 
default is by Artist.    Use the check boxes to control
the printing of certain information.    When checked, the
information will print.    When not checked, that information
will not be printed.    

You, optionally, may enter a Header into the Header edit 
control. This text will be printed at the top of each page 
of output.

You may print to a file instead of the printer by checking
the Print to a File check box.    

To set options specific to your printer, click the Setup button.

After setting any of these options, click the Go button to start 
printing.    After printing starts, an abort print dialog will appear
that allows cancelling the printout.



The Sorted Order specifies the field that controls the 
alphabetic order that compact disk records will
be listed in.    For example, sorting by Artist might make
Alan Parsons Project the first record and ZZ Top the 
last.



Miscellaneous Information
These are general notes on the operation of CD Tray.

Back Up Your CD Library!
Exiting CD Tray
Timers
Releasing Memory
CDTRAY.INI
Bug Reporting
Version Information
License Information
Disclaimer
Credits



BackUps
It is a good idea to make frequent backups of your
Compact Disk Library.    The database is kept in
two files, CDTRAY.DAT and CDTRAY.IXC.    For
maximum safety, keep the database files on a
floppy disk or tape storage device.    Even keeping
the files copied to different filenames on your hard
disk provides a margin of saftety against lost data
as long as your hard disk doesn't fail.

Also keeping an up to date exported text file of your 
database is a good idea.    To export the text file, 
choose Disk Library from the Windows menu to enable 
the Library menu.    Next, choose Export Text File from 
the Library menu.    Enter a filename .    
This will create the text file.    

This file can then be reformatted if necessary and read 
into other applications.    Alternately, bring the file into
NotePad or a similiar word processing program and cut
and paste into other applications.



Exiting CD Tray
It is IMPORTANT that you close CD Tray normally by 
exiting from the Disk Menu.    Turning off your computer
while CD Tray is running could corrupt the database and
make it unusable. (Another reason to make backups!)      
This is not a normal occurence, but is dependent on the state 
of your computer and what kind of manipulations you have 
been doing with the CD Library database files    A good 
precaution against this is to choose Close CD Database in 
the Disk; Options menu while you are playing disks and not 
doing any editting of the database.    This also 
releases memory back to Windows for use by other 
applications.



Timers
CD Tray uses Windows timer messages for all
updating of digital readouts, track highlighting and
so forth.    The CD ROM drive is polled approximately
once every second.    Unchecking the CD Polling menu
item in the Disks; Options menu will turn this polling off.
Turning polling off can minimize the "stress" on Windows
while using other applications and listening to music.
Polling is automatically turned off if CD Tray is minimized
to an icon on the Windows desktop.

In addition, another timer is used if CD Tray is in
program mode.    However, this timer is not turned off while
CD Tray is minimized.    This allows program mode
operation while CD Tray is minimized.    In program mode,
other Windows applications that use timers could affect
the synchronization of the program mode timer.    It is best to
not use other Windows applications which use a lot of timers
while CD Tray is in program mode.

Yet another timer is used while viewing a graphics window.
This makes for a maximum of 3 timers that CD Tray will use
if CD Polling is On (checked), CD Tray is in program mode
and viewing a graphics window at the same time.    Windows
currently provides 16 timers so this should not adversly affect
Windows' operation.



Releasing Memory
To release more memory back to Windows while
listening to music with CD Tray, close the
Compact Disk Library and minimize CD Tray to
an icon on the Windows desktop.    This also turns
off the CD ROM drive polling which leaves Windows
a little less "stressed" and able to devote more time to
other applications.



Description and Features
CD Tray is a Compact Disk Audio Player and Audio Compact 
Disk Database program for Windows.    CD Tray combines the 
look and feel of a real CD Player with an easy, but powerful means 
of storing and categorizing disks into a Compact Disk Library.

Features of CD Tray are:
------------------------------------------------------------------------------------------------------

    * Compact Disk Artist/Title recognition after input into the CD Library.
    * Stores Song Titles and Compact Disk time information.
    * Track Programming.
    * Shuffle Play
    * Save a favorite track program for each disk in your CD Library.
    * Fast Forward / Rewind / Cueing.
    * Segment Play to play a fixed length passage while recording.
    * Track Repeat.
    * Disk Repeat.
    * CD Library capacity of over 2 billion Compact Disks with multiple
        sort keys.
    * CD Library filtering by categories of music in the CD Library.
    * Store dollar value and purchase information for each Compact Disk
        in your CD Library.
    * Disk Library summary and statistics.
    * Disk Libray exporting capability.
    * Ability to run other user-defined Windows programs from CD Tray.
    * Custom 3-D look which mimicks a real CD player.
    * Animated graphics diversion windows for greater music enjoyment.
    * Real-time digital readouts of track number, track length, number of
        tracks, duration, time remaining, etc.
    * All the controls of a real CD player (Play, Stop, Pause, Skip etc.)
    * Complete Windows Help file.
    * The author's firm commitment to future improvements and added features
        as well as free customer support for registered users.



CDTRAY.INI
CDTRAY.INI is a configuration file for CD Tray.
This is where certain options are set so they will
be reset each time CD Tray is run.    

Here are explanations of the current entries in 
CDTRAY.INI:

DbDirectory= 
----------------------------------------------------------------------------------    
This option allows setting the path to the CD Library 
database files on the hard disk.    By default, this path 
is the WINDOWS default directory and this is the 
location that CD Tray will first create the files.    You may 
change this entry to another directory.

For example:      DbDirectory=C:\MMEDIA\CDTRAY

This example specifies to CD Tray that the location of
the CD Library database files are located in the above
directory.    Be sure to copy the files to the directory or
they will be recreated the next time CD Tray is run.

ToolxName= , ToolxPath=
----------------------------------------------------------------------------------    
These specify the menu item names and the directory
paths to any user-specified tools that have been set
using the Add Tool... menu item.    You should not have
to set these entries as it is much easier to let CD Tray
set them for you using Add Tool...

ToolxName is the menu item name.
ToolxPath is the directory path to the executable program.

An example of this kind of entry might look like this.
Tool1Name=Pocket Recorder
Tool1Path=c:\win\prec.exe



License Information
CD Tray is a Shareware product.    As such, it is made available
to the general computing public for evaluation.    Users are licensed
to operate CD Tray on their personal computers for the purpose of
test and evaluation on a trial basis for a period of no more than
two weeks.    If the user decides the program is not of sufficient
merit to warrant purchase through registration with JenJen Software,
program use should cease and the program files should be deleted 
from the computer it is installed upon.    Otherwise, if the program is
deemed useful and is in regular use, registration with 
JenJen Software is required.    

Registered users are those users that elect to pay for CD Tray
and register that payment with JenJen Software.    By virtue of
registration and payment for the program, registered users are
granted a license to continue to utilize the program for as
long as they choose.    This license authorizes the user to use
the program on any personal computer system so long as the 
program is operated on only one computer system at a time.

If you are already a registered user, THANK YOU for 
purchasing CD Tray!    The Shareware concept is a good way
for software authors to distribute their software without the marketing
headaches.    It is only people who register and pay for shareware
software, like you, that makes it all possible. 



Disk Menu

Click the menu item for a description of that item.



Save any changes made to the current compact disk record.



Load a saved program for this compact disk.
This item is disabled unless the current compact
disk has a program that you have saved previously.
CD Tray will load the    program, and go into 
program mode.



Save the current track program.    This item is
disabled unless CD Tray is in program mode.



Invoke a menu of optional items.



This turns off the CD ROM drive polling which 
allows Windows to be a little less "stressed" 
and able to devote more time to other 
applications.    If checked, polling is on. This is 
the default.    This polling is also turned off by 
minimizing CD Tray to an icon on the Windows 
desktop.    Note that if CD ROM drive polling is 
turned off (unchecked) that all digital readouts 
such as Track Time and Elapsed Time will 
cease to function.    In addition, if polling is off, 
CD Tray will not detect that the CD ROM drive 
has stopped, playing or paused.    Turning off 
polling will not stop the CD ROM drive from 
playing and all controls on CD Tray will still 
work.



This will close the Disk Library database files.    If 
the Disk Library is closed, the menu will change so 
that selections that pertain to using the Disk Library 
will not be available.    This also releases some 
memory back to Windows for use by other applications.
You should use this to close the files to guard against 
improper closing of CD Tray (ie. shutting off the 
computer without exiting the program).



Exit the program.    If    any of the current disk's 
information    has been editted and not    saved, 
you will be prompted whether or not you wish 
to save it.



Window Menu

    

Click the menu item for a description of that item.

The current window shown inside CD Tray 
will be checked.



Invokes the Disks Window where you may
browse and edit the disks in the Disk Library.
This menu selection is not available if the Disk
Library is closed.



Invokes the Songs Window where you may
edit the song titles for the current disk and 
instantly play tracks on the current disk.



Invoke an animated graphics window.    These windows 
are for show only and just might make listening to music
at your computer a little more relaxing.

Look for new, more specialized    windows in future 
versions of CD Tray!    The possibilities are endless.



Control Menu

Click the menu item for a description of that item.



Pause playing the compact disk in the CD ROM drive.

This control is disabled if the CD ROM is currently stopped
or there is no disk in the CD ROM drive.



Resume playing the compact disk in the CD ROM drive.

This control is disabled if the CD ROM is currently stopped
or there is no disk in the CD ROM drive.



To Filter a database means a field is chosen
from the record to filter by.    Some criteria is 
given about that field and only records that
match that criteria are listed.



Category Filter Dialog

In this dialog you are a presented a combo
box from which you may choose a category to
filter the Disk Library by.    The combo box will
contain every unique music category you have 
entered for disks in the Disk Library.    You may 
choose one of these and only those records whose 
music category field matches the filter you selected 
will be listed in the Disks Window.    At least one 
record will be shown.    Select <All Categories> to
display all records.    Select <No Category> to display
records whose category is blank.



Compact Disk Library Information Dialog
This dialog presents a summary of various
information about the database.    Some is 
more useful than others.    If you have some 
suggestions on other statistical summay 
information that can be derived from a 
database such as this, please contact
JenJen Software with your suggestions.



Digital Displays

Click on the digital readout for a description.

Note that the time lengths displayed here may not match exactly any lengths that are 
written on the compact disk.    However, these are    the lengths that are returned by the 
compact disk to CD Tray.    Any differences noted should not be more than a few seconds.



Current track that CD Tray is playing or
is ready to play.



Time remaining to play for the current song.
This display counts down from the length
of the track to 00:00.



The elapsed amout of time that has played
from the beginning of the compact disk.    This
display counts from 00:00 to the length of the
disk.



Total number of tracks that are on this 
compact disk.    This display changes only
after ejecting the present disk and inserting
a new one.



Total length of time this compact disk will play.
It is the sum of the lengths of all the tracks plus
any time at the start, between songs, and at the 
end of the disk.    These times vary greatly between
different disks.



Remaining time left to play on this compact disk.
This readout counts down from the length of the 
disk to 00:00.



This is a status indicator that indicates what 
CD Tray is currently doing.    This    display 
will indicate Play, Stop and Pause.    It will be
blank when no disk in inserted in the CD ROM
drive.



Fast Forward / Rewind Tool

This tool allows control of Fast Forward,
Rewind and Cueing operations for CD Tray.
The current track that is playing or is
next to be played is the target of its
operations.    This tool can be executed at
any time except when CD Tray is in
program mode.

The current song title is displayed at the
top of the dialog.    The current position
of the scroll bar's thumb, relative to the
length of the current track, is displayed
above the scroll bar.    The length of the
track is displayed to the right of the scroll
bar.

The scroll bar controls the Fast Forward, Rewind
and Cueing operations.    Clicking on the scroll
bar will increment/decrement the current playing
position by 10 seconds.    Clicking the arrows at
either end of the scroll bar increments/decrements
by 1 second.    You may also drag the scroll bar
thumb to increment/decrement in larger amounts.

When CD Tray is playing, this tool controls
Fast Forwarding and Rewinding.    CD Tray will skip
to the position indicated by the scroll bar's
thumb and continue to play.

If CD Tray is stopped, Cueing is performed.
After positioning the scroll bar's thumb to the
position desired, clicking the Play Control will
start CD Tray playing from the position set by
the FFwd/Rew tool.

This dialog is a modeless dialog.    This means that
you may leave the dialog in view on the screen and
still have access to the controls, menus, etc. of
CD Tray.    By leaving this tool in view while CD
Tray is playing you can watch the thumb move
automatically to the relative position of the
current track that CD Tray is playing.

Keep in mind that this tool works for the current



track that is playing or is next to play.    You may
use CD Tray's Skip Right and Skip Left controls to
move to a different track if desired.



Segment Play Tool

This tool allows a small segment of the
current track to be selected. Selection in
this sense means selecting a starting position
for the current track and then selecting an
ending position.    CD Tray will play the
segment from start to finish and then stop.
The primary purpose of this tool is to control
play while recording though playing segments of
certain tracks can be mildly entertaining.

This tool can only be selected from the
menu if CD Tray is stopped and is not in
program mode.

Using the tool is easy.    The top scroll bar
controls the starting position of the segment
to be played.    The bottom scroll bar controls
the ending position of the segment to be played.
The relative position to the current track is
displayed above each scroll bar.    After
selecting the segment to be played, press the
Go button to begin play.    You may press the Go
button as many times as you wish to play the
segment.    Both scroll bars will not allow movement
of the its' thumb into an invalid part of the scroll
bar.    In other words, moving the scroll bar's thumb
that controls the end of the segment to a position
that is previous to the beginning of the segment is
not allowed and the scroll bar will not allow that
movement.

This dialog is a modal dialog.    This means that
while the dialog is in view on the screen, access
to the controls, menus, etc. of CD Tray will not
be available.    However, you can switch to other
applications using the mouse or by pressing the
Alt-Tab combination.



Tools Menu

Click the menu item for a description of that item.



Track Programming Dialog

This dialog is used to program CD Tray.
Programming means that individual tracks
from the current compact disk can be selected
to be played.    The tracks can be selected
in any order and as many or few as desired.
This track program can be saved, if desired.

When first displayed, all the songs will be
listed in the 'Available' list box on the left.
These tracks are available for programming.
The 'Programmed' list box on the right, lists the
tracks that are programmed.    It is initially
empty.

Above each list box the total time length of all
the songs contained in the corresponding list box
will be displayed.    The programmed length will
increase as tracks are programmed while the
available length will be decreased by the
same amount.

Programming CD Tray is easy.    To select a track
click on the track and then click the Select button.
Alternately, you may double click the track title
to do the same thing.    This will move the track
title from the 'Available' list box to the
'Programmed' list box.    You also may remove a track
from the 'Programmed' list back to the 'Available'
list box by selecting the track and clicking the
Reject button.    Again, you may double click the
track to accomplish the same thing.

If you wish to play the tracks in a random order,
click the Shuffle button.    This will move all of the
tracks from the 'Available' list box to the 'Programmed'
list box.    You may click the Shuffle button as many
times as desired and you also may remove tracks from
the 'Programmed' list box as described above.

After the tracks are programmed that you desire to
play, click the Done button.    This will launch CD Tray
into program mode.    The Review Program dialog will 
appear to the right of CD Tray listing the program and the 



first track programmed will be highlighted in red in the
Songs Window.

To start the program, click the Play Control or select
Play from the Control menu.    All of CD Tray's controls
(and corresponding menu items) can still be used.
One difference is skipping to the next and previous tracks
using Skip Right and Skip Left will cause CD Tray to skip
to the next or previous track that is programmed. Stopping
CD Tray while in program mode will cancel program mode
and return CD Tray to Continuous Play.

While CD Tray is in program mode, you may save the current
program for this disk in the Disk Library.    This is
done by selecting the Save Program menu item in the
Disk menu.    One program may be saved for each disk in the
Disk Library.    If a saved program already exists, it will be
overwritten.



Review Program Dialog

This is a dialog which lists the tracks that are currently 
programmed.    This dialog appears automatically after tracks 
are programmed using the Track Programming tool.
The dialog can be closed, if desired, by clicking the Close 
button.    If it is closed, and CD Tray is still in program mode, it can
be recalled by selecting the Review Program menu item in the
Tools menu..    The Review Program menu item is only 
available if CD Tray is in program mode.



Selecting this item will make CD Tray
restart the track that is currently playing.
This item is disabled when CD Tray is
stopped.



Select this    item to make CD Tray play the
current track continuously.    When this menu 
item is checked, Track Repeat is on.



Select this    item to make CD Tray play the
current compact disk continuously.    When this 
menu item is checked, Disk Repeat is on.



Add    a Tool Dialog

Adding a tool allows you to specify other tools or programs you 
wish to execute from CD Tray.    You will specify the name you 
wish to put on CD Tray's menu and the executable program name.
You may add up to 5 items to this menu.    Put an ampersand (&) in 
front of the letter of the menu item name to make it the hot key for 
the item.    Be careful not to duplicate any other hot keys you have 
defined on this popup menu.

The Add Tool dialog will be displayed.    You can type in the 
information yourself or click the Browse button.    This will present 
a file dialog that can be used to browse through the directories 
of your hard disk to find the executable (.EXE) file.    Likely 
candidates for some tools to add to CD Tray's Tools menu 
are Mixers, WAV Recorders etc.



Delete a Tool Dialog

This dialog is used to delete any of the user-defined 
tools added to CD Tray's Tools menu.    Select the tool
from the combo box, and click Ok to confirm.



Reveals another popup menu with tools or programs
you wish to execute from CD Tray.



An example of a user-defined tool.



Adding a tool allows you to specify other tools 
or programs you wish to execute from CD Tray.



Presents a dialog with which you may delete
any of the user-defined tools added to CD Tray's 
Tools menu.



Credits
Written by Richard Rakes, JenJen Software

Thanks to...
----------------------------------------------------------------------
My wife and daughter for putting up with my late 
night espresso programming.

Borland, for creating great Pascal products.

Microsoft, for Windows

Led Zeppelin, The Grateful Dead, Pink Floyd, 
The Rolling Stones, The Beatles Jimmy Buffet, 
Peter Gabriel, Pearl Jam, The Red Hot Chili
Peppers plus so many more for the inspiration.

                                                                                  



Driver Setup for CD ROM Audio in Windows 

Three drivers must be installed for proper operation of Compact Disk
Audio in Windows (CD ROM Audio Support).

They are:
        1.    The CD ROM manufacturer's CDROM device driver 
        2.    Microsoft's MSCDEX.EXE (CD ROM Redbook extensions)
        3.    Windows 3.1 MCICDA.DRV.    

The manufacture's driver interfaces directly to the CDROM device.    
It in turn interfaces with MSCDEX.EXE.    MSCDEX.EXE ,in turn,
 interfaces with MCICDA.DRV.

CD Tray interfaces with the MCICDA.DRV driver using the MMSYSTEM
Dynamic Link Library (DLL) that is distributed with Windows 3.1 or as 
a supplement to Windows 3.0.    If you use Windows 3.0, contact Microsoft
on how to get the necessary files.

All three drivers must be installed to play audio compact disks.
Consult your CD ROM drive documentation on setting up the first two
drivers. When the Windows 3.1 setup program is run, it checks for the 
presence of MSCDEX.EXE.    If it is found, it will create an entry for 
MCICDA.DRV in your SYSTEM.INI file.    However,    it will NOT install 
the driver!    This must be done by the user after the installation is completed, 
CD Tray will notify you if    MCICDA.DRV is not entered in SYSTEM.INI.

To install the MCICDA.DRV driver for Windows 3.1, follow these steps...
1.      Run the Windows Control Panel and select the Drivers icon.
2.      Press the ADD Button.
3.      Select the "[MCI] CD Audio" entry and click OK.
4.      Insert the Windows Distribution Disk, if asked for and follow the instructions.
5.      Restart windows.    You should now be able to Run CD Tray to 
            play audio compact disks..

If after the above steps you are still not getting the MCICDA.DRV to run, 
follow these instructions:
        1.      Edit the SYSTEM.INI file found in the Windows default directory.
        2.      Find the [MCI] section.
        3.      There should be a "CDAudio=mcicda.drv" entry.    If not, add it.
        4.      Save SYSTEM.INI and exit the editor.
        5.      Do a directory listing on your <windows>\SYSTEM directory.
        6.        Is MCICDA.DRV present?    If not:
                      1.      Search the Windows 3.1 distribution disks for the file "MCICDA.DR_".
                      2.      Use EXPAND.EXE to expand the file to <windows>\SYSTEM.
                      3.      Restart windows.



Disclaimer
JenJen Software hereby disclaims all warranties relating to CD Tray,
whether it is expressed or implied, including and without limitation
to any implied warranties of merchantability or fitness for a
particular purpose.    JenJen Software cannot and will not be liable for
any special, incidental, consequential, indirect or similar damages due
to the loss of data or any other reason through the use of CD Tray,
even if JenJen Software or an authorized agent has been advised of the
possibility of such damages.    Further, in no event shall the liability
for any damages ever exceed the price paid for the license to use
CD Tray, regardless of the form and/or extent of the claim.    The
user of CD Tray bears all risk as to the quality and performance
of the software.



Library Menu

Click the menu item for a description of that item.



Reveals another popup menu in from which 
the sort order for the Disks Window can be 
chosen.    The current sort order will be checked.



Select this to sort the Disks Window by the Artist field.



Select this to sort the Disks Window by the Title field.



Select this to sort the Disks Window by the Category field.



Export to Text
This selection will dump all records in the
Disk Library to an ASCII text file.    This file 
can be used in any number of ways.

A File Open dialog will be displayed.    Enter the
filename for the dump file, click Ok and the Disk
Library will be dumped to the text file.

This file can then be reformatted if necessary and read 
into other applications.    Alternately, bring the file into
NotePad or a similiar word processing program and cut
and paste into other applications.



Bug Reporting
As programming goes, testing software can be
boring.    However, it is a very necessary step in
the creation of software.    CD Tray has been tested
thoroughly, however problems can occur.

If you have noticed a problem or bug with CD Tray,
PLEASE contact JenJen Software describing the
problem and how it might be duplicated.

Suggestions are welcome also!

Please recognize that this program has a few 
limitations due to several factors.    One big factor 
limiting the program, is the use of Windows timers.
This is especially true in program mode.    CD Tray 
could be improved in this area and probably will be
in a future version.    If during program mode, skipping to 
the next track becomes unsynchronized or late, be aware 
that this is primarily due to Windows handling of timer 
messages.    This can be minimized by keeping Windows
activity to a minimum during CD Tray program mode 
operation.



Help Menu
From the Help menu you can receive help on using
all of the features of CD Tray.    For finding a topic,
select the Index menu item.    For information on a main 
topic, select one of the topics listed.

For information on using the Windows Help System, 
select Help on Help.

Note that CD Tray's menu is context sensitive in a 
general sense.    If, for example, you are about to
make a selection from the Tools menu you may
press F1 to invoke the help system.    The topic displayed
will be about the Tools menu.    



A track program is a list of tracks to be played
by CD Tray that have been selected using the
Track Programming tool in the Tools menu.

A track program can be saved, after programming
is completed using the Save Program menu item
in the Disk menu.    The track program can be recalled
by selecting Load Program menu item also in the
DIsk menu.



That's Me!!!



Registration Information
CD Tray is the sole property of JenJen Software.
The shareware version may be freely copied and 
transferred to individual parties for evaluation purposes.
It may be posted on Bulletin Board systems (BBS) for
electronic access as long as NO FEE is charged for its
distribution except for private BBS operations that charge
a regular user subscription fee.

CD Tray is a Shareware product.    Shareware is a computer
program distribution/marketing method that permits potential 
buyers to try the program prior to purchase.    It is NOT free 
and it is NOT in the Public Domain.    You are given the right to
use this program for a period of not more than 2 weeks.    If, after
evaluating the program, you find it    to be useful enough to use it
on a regular basis, you are expected to pay for it by registering 
with JenJen Software.    

The registration fee is $29.00, plus $3 for shipping and handling.

Please be advised that credit cards cannot be accepted.
Checks/cash/money orders ONLY, please!

With registration you will receive:
    - The fully functional version of the LATEST CD Tray program 
          and help files on your choice of disk format (5.25 or 3.5 disks).
    - Unlimited Technical Support.
    - Free or minimal cost upgrades for major program revisions.

                  You may register CD Tray in the following way: 
                    1) By mail with check, cash or money order to:                

                          JenJen Software
                          7 Kettering Lane
                          Hampton, Va 23666

                    Note:    You may print an order form from CD Tray 
                                              if desired or use the enclosed order form in 
                                              the file ORDER.TXT.

After receipt of registration payment, Technical Support 
will be provided through two means:

        1) By mail at the above address.

        2) Electronically through CompuServe: ID# 73700,3137

        Note:    Please include your phone number in case 
                                  a phone call is required.

Technical Support is unlimited to registered users.
Technical Support is supplied to unregistered users 
only if the problem affects the ability to reasonably 
evaluate the software.



One of the great strengths of the Shareware concept is
the interaction between the program author and the users.
If you have a problem, questions or any suggestions for 
improvement, please contact JenJen Software.

                                    Thanks for supporting Shareware authors!    :)

                                                          
                                                        Richard Rakes
                                                        JenJen Software
        



                                                                                            CD Tray Order Form
        Choose from the Windows Help menu, File; Print Topic to print this order form.

        Name.........
                                                    -----------------------------------------------------------------------------------

        Address......
                                                    ----------------------------------------------------------------------------------

                                                    ----------------------------------------------------------------------------------

                                                    ----------------------------------------------------------------------------------
                                  
        City, State
        & Zip Code...
                                                    ----------------------------------------------------------------------------------

        Phone........(                  )                        -                                        Compuserve ID#
                                                    ---------------------------------                                                                  
-------------------------

        Disk Format          5.25    [          ]                Payment Method...    Cash    [              ]
        Desired                            3.5      [          ]                                                                                            Check [        
]
                                                                                                                                                                      Money Order
[              ]

                              CD Tray for Windows......... $                      29.00
                              Number of copies................ X    [                                            ]
                                                                                                                                      -------------------------
                              SubTotal................................. $    [                                              ]
                              plus Shipping & Handling..$                          3.00

                              Total Amount......................... $ [                                                ]

                                  ----------------                  JenJen Software
                                      Mail To :                      7 Kettering Lane
                                  ----------------                  Hampton, Va    23666

        Comments, Questions, Criticisms? __________________________________

      ____________________________________________________________________

      ____________________________________________________________________

      ____________________________________________________________________

      ____________________________________________________________________

      ____________________________________________________________________

                                                                                          Thank You for supporting Shareware!!





    
Click here for more information.



Click here for more information.

This version is limited to a dozen compact disks.



Version Information
 Version 1.0 - released 01/19/93

 Version 1.1 - 01/28/93    
            (Maintenance Release)

                  Fixed repaint problems mainly with the 
                        digital displays.

                  Fixed repaint of the Songs Window when 
                        entering program mode.

                  Closes FFwd/Rew tool when choosing 
                        the Program Tracks dialog.    This tool cannot 
                        be present when in program mode and previously
                        it would be left open and cause programming to 
                        not work correctly.

                  Closes FFwd/Rew tool if disk is ejected.

                The Help menu is no longer disabled 
when 
                        the CD Library is Closed.

                No longer duplicates the user-defined 
tools 
                        menu items when the CD Library is re-opened.




